I. Setting up the Scene

We are going to create an animation showing a word flying in from the right side of the screen, wrapping around a sphere (the world or a ball), spinning that object, then flying off the left side of the screen. First we need to set up the text characters and their parent objects. Pick a 5 to 8 letter word.

1. Create the first parent by using the sphere tool to create a sphere in the center of the world (at 0x, 0y, and 0z). Change the uniform size in the INFO floater to 0.25 units. Then, in the OBJECT TAB, uncheck the visible and casts shadows boxes, to make the parent invisible. You can change this from time to time if you need to see the parent or unlink objects.

2. Create the first character of the word. Use the plane object to put a square at the center of the world...
Under the OBJECT menu, select CONVERT TO SPLINEFORM to convert the primitive object to an editable spline object. You should be taken into the extrude workshop.

3. Once there, select the square outline and delete it. Use the Text tool inside the workshop area to create the first character of your word. You want to choose a font with a nice outline, preferably a Serif font (to give your letter objects some visual interest), then type the first letter into the dialog box. Hit the return key to accept the letter. Make sure that the outline of the letter is centered in the workshop window. If it isn't, it'll throw off your coordinates back in the world.

4. Give the object an extrusion depth. Open up the PATH FRONT window. You should see a dark gray line at the 0x axis. This indicates that the object is just a flat object, with no depth. Choose the PEN tools from the TOOLS palette and place a point at about half an inch above the dark gray line, and half an inch below it. This will give your letter a depth of one inch. Now, you can see that this a little too deep. You may want to change it so that it is only half an inch deep. Use the ARROW tool to select each point. Use the arrow keys to move the points closer to the center. You need to do this uniformly (the points equal distance from the center axis).

5. Exit the workshop.

Now would be a good time to save your scene if you haven't already done so. (FILE>SAVE)
6. Now we need to position the character in relation to its parent object. In the info floater, change the Y coordinates to 5.00. Now the character will be five units away from the parent.

7. Next, we need to link the character to the parent. Open the SEQUENCER (under the WINDOWS menu). Locate the two objects in the list. They should be named Sphere and Square. First, we want to rename the objects so we can identify them easier. Select the sphere and change its name (in the object tab) to “first letter”-parent. I have I-parent as the name of my first sphere. Then, select the square and change its name to the letter's name. Drag the letter object name over the name of the parent. A pink arrow should appear next the parent’s name, and the letter object name should appear indented and below it in the list.

8. To create the rest of the characters, just copy and paste the I-Parent object and edit the text object as in steps 2-5.

9. Next we need to create a MOVE parent and a SPIN parent. The MOVE parent will only be used to move the entire word along the x axis. Moving this object will not affect the individual objects' animations later. Place a sphere at the center of the world (0,0,0) and make it invisible by using the Object tab's functions. Change the uniform size using the INFO floater to 0.25). Copy and paste the sphere to create the SPIN parent. The SPIN parent will only be used to rotate the text later in the animation. You will want to name these parents to keep track of them.

10. First, make the Move sphere a child of the Spin parent. Then, make all of the text parents children of the MOVE parent. You can get a better picture of this by looking at this screenshot. Notice how the objects are arranged.
11. Now you'll need to create your ball or world object for the text to spin. Place a sphere at the center of the world. Change the uniform size to 4. You can create any type of surface that you want for this, just remember that you should be able to tell that the ball is spinning (so a flat color would not work). You can try out this beach ball texture. (Use spherical mapping). When the ball is placed, you can start to animate.

II. Animating

Now that you've set up the scene, you get to animate your objects. In this case we are going to use the Spin Animation assistant in conjunction with straight unassisted animation.

1. First of all, I suggest that you sketch out your motion path on a piece of paper. This will allow you to get a feel for how the text needs to move around the ball, and also let you see when the text needs to curve around the shape of the ball.

2. After the motion path is drawn, you'll need to break the motion into parts. The text has many motions which will have to be dealt with separately. This is why we made the parent objects. The ball object has only one motion and will be the simplest to animate.

3. Select the ball or world object. Select the first eventmark of that object. Go to the ANIMATION menu, pull out the ANIMATION ASSISTANTS flyout menu and select SPIN. Try not to cancel out of this dialog as it may crash your computer (on versions previous to ID4.5 it WILL CRASH). You want the ball to rotate about 5 times in 5 seconds, clockwise around the Z axis (vertical axis). Enter in the values and click the OKAY button. You should see a line of eventmarks, connected by a blue line, to the right of the object name in the sequencer. Make sure all of the eventmarks are selected and move them so that the spin will start at 2 seconds on the timeline. Select the first mark, and option-drag it to 0 seconds. This will copy that eventmark and make sure that the ball does not start to spin until the 2 second mark. Okay, now we can forget about this for awhile.

4. Now we need to spin the SPIN parent for the Text. Follow the same process as for the ball object, making the spin parent rotate 2 times in 2 seconds clockwise. This will make the object spin around the ball twice. Move these eventmarks so that this rotation also starts at 2 seconds on the timeline (we will mess with this later). Option-drag the first eventmark for this rotation just as you did for the ball (to 0 seconds).
5. Now things get a bit more complicated. We need to move the move parent (and its character children) off the camera view. Select the MOVE parent and change its X coordinates to +75 units or more until it is totally off the screen.

6. Next, we need to position the characters so that they are in the correct word positions. Select the first character's parent object and change its X value to about +65. Then move each character along the X axis (using the Info floater) so that the word is lined up correctly (it should be straight) and still out of the camera view. Once this is done, it is time to start the animation.
7. Your word needs to be at the original position (0,0,0) by 2 seconds. Move the timemarker (the red line indicator) to two seconds. Select the MOVE parent and change the X value back to 0. A blue line should show up now between the 0 mark and the 2 second mark in the sequencer indicating that movement has taken place.

8. Now we need to curve the word around the ball. Move the time marker to 2 seconds. Select the First character's parent and open the Info Floater. Change the Z rotation value (second row, third box) to -60 degrees. Rotate the rest of the text objects parents, keeping nice spacing between the characters. I usually start out by using -60, -45, -30, -15, 0, 15, 30 and so on, then adjust the spacing according to the width of the actual character. This will give you characters arrayed in a semi-uniform circle. Select the first eventmark of each character parent (hold down the shift key while selecting to select more than one eventmark at a time). Option-drag the eventmarks to the 1.09 second mark to make sure that the characters do not wrap around the ball until they are in the correct position.

9. Now we need to tweak the characters' animations. Use the Zoom function on the Sequencer (upper right hand corner of the sequencer) to get a spread out view of the timeline. Look at the eventmarks for the character parents. We need to stagger those so that the text curves around the ball properly. The first character eventmark should remain the same. The second should be moved slightly to the right (later in the timeline). The others should fall somewhere between the first and the last character of the word.
10. Once this is done, you might want to preview the animation to make sure that the timing is correct. Click the Animation tab on the Info floater. Change the mode to wireframe, make sure that the camera view is visible, and click the play button (arrow). Hopefully, things looks fairly good.

11. Once you are satisfied with the timing, you can start to animate the word moving off the screen. Select the last event mark that you have for the MOVE parent. Option-drag a copy to the 3.5 second mark. Then, move the time marker to the 4.5 second mark. Change the X coordinates in the Info Floater to -75 units. This will make the object exit to the left. Preview the animation again and note when the first character is at the front edge of the ball as the spin object stops spinning. Select all of the eventmarks for the character parents and option-drag copies to that time. You may need to tweak the individual settings in order to get the effect of the text peeling off.

III. Surfacing, Lighting, and Camera

After the scene is animated to your satisfaction, you'll want to change the camera view, the lighting, and the surfaces of the objects.
1. Move the time marker to the 0 mark. Locate and select the first text character. We want to create a reflective surface that will be applied to the letter objects. Click the **Surfaces** Tab. Scroll down until you see the **Chrome** surface, then double click it to apply it to the object. This chrome is a little too dark, so we want to lighten it up. Click the **edit** button on the **Surfaces** tab. This will bring up the surface editor. Click on the the **Edit Color...** button to get to the color picker. Make the gray a little bit lighter (or even add a bit of blue or red). Click okay to get out of the picker. Back in the original dialog, you'll need to mess with the Diffuse Shadow settings to get a lighter chrome surface. After you are satisfied with the settings, hit the Okay button to accept the changes. Apply the surface to the rest of the characters.

2. This isn't quite done yet. We need to have something for the chrome to reflect, so we will add an environment map. Go to the **EDIT** menu and select the **ENVIRONMENT** option. Under the Environment Map area, use the pull down menu to select **Load Image...** Find the **Environment Maps** folder inside the Infini-D folder. Select the **Chrome Env. 2.pic** file. This will make our reflective characters more interesting.

3. Now we need to set up some lights. We will need a light that follows the text as it moves. We will also need some nonmoving lights that will be focused on the ball (and later the word). Place three targeted lights: The first two will be targeted on the ball (the target objects will be at (0,0,0)), the third will be targeted on the text and will be linked to the **MOVE** parent. Place the first light to the left of the ball and slightly above where the text will fall. Change the color of the light to red, and make sure that you set the shadows to soft shadows. The next light will be blue, and to the right of the ball and slightly higher than the ground plane (0). The third light will be white, but at 75% Intensity-- no shadows. Link the white light and its target object to the Move object.

4. Next, we need to move the camera so that we have a nice view of our animation. Depending on what setting you want to put this animation in, you'll either want the camera to be lower than ground level, or above the ball object. For a straight "flying logo" type thing, you want to be below ground level. Make the view exciting and dramatic! If you want the background to be like a beach scene, be above ground level and even above the ball. It all depends on your personal taste and the context. Have fun with this!

Preview your animation with the new camera view. Is it ready to render?

**IV. Rendering!**

Now, we get to see if our hard work paid off. You might want to find a particular frame to render first, before rendering the entire animation.

**To Render a Single Frame**

1. Select the frame. Try to pick one which includes the text as well as the ball. Go to the **FILE** menu and choose **Render**. You will be popped into the render dialog box. There are three tabs in this dialog, make sure that you are in the first tab, the **Render** tab. Make sure that your rendered view is the Camera View,
set the mode to Ray Trace, medium Anti-Aliasing, and be sure that the transparency and the shadows are turned on.

2. Next, click on the **Image** tab. Make sure that you set the render size to 320 x 240. This is the optimal QuickTime size. Then, get to the **Animation** tab. Select the CURRENT TIME option and hit the **Render** Button.
The regular save dialog will appear. Save your file as a PICT or TIFF. You can change it later if you need to. You will be popped into the actual render interface where the rendering will take place. Let it do its business, and look at the image as it is rendered. Do you see any problems? If so, you can exit the renderer and get back to the "world" and fix the problems. Render the frame again. If it is right, it's time to render the entire animation.

**To Render the Animation**

Follow the instructions for the single frame render, but in the Animation tab, make sure that the Entire Animation option is selected. Make sure that the end frame is at the actual end of the animation. Sometimes you can end up short a couple of frames if you don't catch it here.
1. Click the **Render** button and save the as either a QuickTime movie, or a series of PICT images. I usually render to PICTS and put them together using PICTstoMovie, or Graphic Converter. This way I have more leeway to experiment with different compression modes vs. Image Quality. If you choose to do QuickTime, click the **Options...** button. You will have several compression choices to choose from. If you have QT3, choose the Sorenson CODEC. It has the best compression and fairly high quality. The Animation option does not compress at all and has the highest quality if you set it to 100%.

**Note:** Make sure that your color depth is always either COLOR, or Millions of Colors. Anything else in ID4.01 will give you nothing but a black screen when you open it later.

Look at your animation! Pretty simple. You can use these principle to create more complex animations as well as this simple one.

Have Fun!

Jennifer

Last Modified: February 10, 1999